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ABSTRACT

A collagen molecule was chosen to be manufactured for use in classroom setting.

The collagen model was modeled with the SolidWorks and Catia software

packages. One chain of space-filled Collagen CGD was modeled with

SolidWorks, and the entirety of space-filled Collagen BKV and 1CGD was

modeled with Catia. The feasibility of manufacturing the model with rigid molds

was examined, and it was shown that this strategy is infeasible. One chain of

ball-and-stick Collagen 1CGD was begun.

This thesis details the steps in creating the computer models and determining the

manufacturing feasibility of the collagen physical model.

Thesis Supervisor: David Gossard

Title: Professor of Mechanical Engineering
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Chapter 1

Introduction

Protein molecules, collectively the basis for organic life, are vital parts of the

study of biology. There are endless varieties of proteins, and they can be so large

and complex that trying to understand the basic mechanisms can be daunting.

Indeed, it can be difficult to simply visualize a large, spiraling, folding

polypeptide chain.

There are currently several technologies devoted to the visualization of proteins.

Online databanks exist that store coordinate information for the atoms of

particular proteins and other molecules. One can use software programs to render

these coordinates into electronic visualizations. Different aspects of the protein

can be focused on as well: the geometric shape, the bonds, or the curling pattern

can be visualized, for example.

Nevertheless, in a larger classroom setting, even this technology is not always

sufficient. The experience of manipulating a computer model, while informative,

is lacking compared to holding and touching the real thing. Of course, protein

molecules are sized on the atomic scale and impossible for us to see and

manipulate with our bare hands. Therefore, a three-dimensional physical model of

a protein could serve to provide students with a learning experience that might

surpass a computer model's impact.
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Collagen, detailed in Section 2.1, is a good choice for a protein because its

components have a relatively simple, symmetrical structure with respect to each

other. Students holding a model of collagen in their hands could learn about the

shape, molecular patterns, and self-interaction of the protein.

Therefore, the overall scope of the combined efforts of this thesis and that of my

colleague Emily Cofer is to design and produce a physical model of the collagen

protein for use in a teaching environment. This thesis is confined to the computer

design of the protein, as well as using a computer model to determine which

manufacturing techniques are feasible. In the following chapters, the collagen

protein as well as visualization options will be discussed. Computer modeling

programs and various manufacturing techniques will be touched upon. A very

detailed set of instructions on how the computer files were made will be

explained, with enough detail for one to be able to completely recreate the design

experience. A study on the feasibility of using a rigid mold to cast the protein

model will be performed using the computer models created. Finally, conclusions

about the design process and future recommendations for the project will be

considered.
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Chapter 2

Background

Chapter 2 provides information on the various aspects of this thesis. It is

important to be knowledgeable of the nature of collagen as well as different ways

of visualizing the protein. Likewise, an awareness of different computer modeling

and physical model manufacturing techniques is important to understand the

experimentation and work that went into this project.

2.1 Collagen Protein

Collagen is a very abundant protein in the bodies of animals. Comprising 25% of

all protein in humans, it provides our bodies with structural support [1].

Specifically, its great tensile strength makes it a good fit for being the primary

component of ligaments and tendons [2]. It makes up 75% of human skin, and it

plays a vital role in the regeneration of damaged body tissue [3].

A complete collagen polypeptide consists of three helices that wrap around each

other. Figure shows a partial representation of the triple helix. Then within

each helix, there are primarily three different repeating amino acid units: glycine

(GLY), proline (PRO), and hydroxyproline (HYP) [2]. This pattern repeats

throughout the collagen chain, with some exceptions. The three-letter standard

abbreviations of these amino acids are listed after the name.
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Figure 1: Partial collagen triple helix representation. Two collagen polypeptides

are pictured; the top one assigns each helix a unique color. [1]

There are a variety of different collagen configurations, each with different

variations in the repeating pattern. Two of these configurations are Collagen

1BKV and Collagen 1CGD. The former contains several nonstandard amino

groups in the middle of the chain: isoleucine (ISO), threonine (THR), alanine

(ALA), arginine (ARG), and leucine (LEU), breaking the pattern considerably.

However, Collagen 1CGD only breaks the pattern once, with an alanine residue

replacing one glycine residue.

2.2 Protein Visualization

A very popular resource used to visualize proteins like collagen is the RCSB

Protein Data Bank (PDB) [www.pdb.org]. The PDB contains spreadsheets for

many proteins that list spatial coordinates for every atom in the molecule. The
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names "IBKV" and "1CGD" are actually PDB IDs that identify the two collagen

variations.

The PDB also stores a list of various software that can be used to visualize

proteins and other molecules. This list can be found on the PDB website at

[http://www.rcsb.org/pdb/software-list.html. More important than the actual

visualization tools, however, are the visualization alternatives themselves. Two

popular visualization alternatives are called space-filled" and "ball-and-stick." A

space-filled model shows the complete geometry of the atoms, but it cannot show

a detailed view of which atoms bond to each other. The ball-and-stick model does

not preserve the actual atomic radii, but it shows which atoms are bonded to one

another. Figure 2 shows a space-filled model, while Figure 3 shows a ball-and-

stick model.

Figure 2: Space-filled model. Each sphere represents an atom, and their radii are

sized in proportion to the actual molecule.
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Figure 3: Ball-and-stick model. Each "ball" represents an atom, and each "stick"

represents an atomic bond.

2.3 Solid Modeling Programs

There are a number of computer modeling programs available, each with its

specialties and weaknesses. Two computer design suites available on MIT

Windows Athena stations are SolidWorks Education Edition 2003-2004 and

Catia V5, each a product of Dassault Systemes. They have slightly different user

interfaces, and their relative merits are detailed in Chapter 3.

A solid modeling computer program allows for the design of a part in an

electronic setting. As such, the end product of a solid modeling program is a

computer file. There are a number of standard electronic formats that

manufacturing sites can use to fabricate designs. Both SolidWorks and Catia

have their own specific format, but they are able to convert files into more

general formats. One of these popular, general formats is called STL. STL stands

for "stereolithography," [4] which is discussed briefly in Section 2.4. An STL file

consists of a myriad of triangular surfaces that define the outer surface of the

solid model. The smaller the triangles, the smoother the overall surface, but the
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more information the STL file holds. A complex geometrical shape like a collagen

molecule can result in an STL file larger than 50 MB.

2.4 Manufacture Techniques

Many different manufacturing techniques exist once the design phase of a part is

complete. Usually, the more complex a design is, the more complex its

manufacturing technique. Also, different techniques are sometimes better suited

for different purposes. For example, a mill and lathe work well with aluminum

and can create detailed features, but these machines are not optimal for mass

production. Molding and casting techniques allow for faster production of parts,

but because these processes are more automated, they can be limited in the

geometry they are able to produce.

Collagen has a very complex geometry; therefore, the more conventional

manufacture techniques are not feasible. For instance, it would be possible but

painstakingly difficult and time-consuming to use a computer-automated mill to

produce a collagen physical model. A better strategy would be to combine the

versatility of rapid prototyping with the repeatability of casting parts from

molds.

Rapid prototyping is often conceptualized as "three-dimensional printing" [5].

There are several techniques with rapid prototyping that quickly produce a three-

dimensional part. The first technique to be invented was stereolithography, and it

works by starting with an STL file, slicing it into very thin layers, and

constructing the slices one layer at a time [5]. These layers consist of liquid

photosensitive polymers that, when exposed to ultraviolet, become solid [5]. A

newer technique, invented at the Massachusetts Institute of Technology, is Three
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Dimensional Printing. This technology also constructs physical parts as an

aggregation of slices. Instead of using photosensitive polymers, though, it uses

any material that can be made into powder form, and it combines the slices with

a binding substance [6].

Different molding and casting techniques are also available. The main issue for

complex shape like collagen is if it can be cast in a rigid mold. As Chapter 4

details, a rigid mold has limitations on how the part can be separated from it. A

flexible mold might be necessary due to the many contours of the part. One

technique that can produce a flexible mold is Room Temperature Vulcanization.

This process yields a flexible silicone mold that can be used to cast a small

number of parts [7]. The molds retain detail well and accommodate a large

variety of part materials [7].

12



Chapter 3

Space-filled Collagen Model

Both SolidWorks and Catia were used to make computer models of a collagen

protein. While SolidWorks is a useful and very capable solid modeling package,

its user interface was cumbersome and not as well-suited as Catia for three-

dimensional object creation. Catia provided better flexibility and more intuitive

controls for creating and placing features in three-dimensional space. Therefore,

SolidWorks was abandoned for Catia as the software package of choice for the

creation of solid models.

One should note that in the creation of the space-filled models, the absolute

dimensions are not important, so long as the same unit of measure is used

consistently in a given model or set of models. The STL files carry the

dimensions, but they can be scaled to fit the constraints of the manufacturing

process that will make a physical model from the file.

3.1 SolidWorks Approach

In SolidWorks it is inconvenient to make a model like Collagen 1CGD in the

SolidWorks Part domain. The solid model comprises a collection of spheres, each

representing an atom, and each with its own 3D-space coordinates. To create a

point with arbitrary 3D-space coordinates in a SolidWorks Part file, one can use

the 3D Sketch command from the Insert menu. However, to create a sphere

centered at this point, one must first create a plane containing the point, then

create a sketch of a semicircle whose diameter intersects the point, and finally
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revolve this semicircle about the diameter. As such, it is more convenient to work

in a SolidWorks Assembly file. One can create Part files for each atom, then

insert them into the Assembly file at desired points.

A spreadsheet of coordinates for Collagen 1CGD, available online at

[http://www.pbd.org], was used to determine the coordinates and radii of the

atoms making up the protein. Only one chain, Chain A, was made. First, the

individual atoms were created as SolidWorks Parts. Starting with the carbon

atom Part file, the Front plane was selected. A sketch was created on this plane

by selecting the Sketch command in the Insert menu. Using the Circle tool from

the Sketch Tools palette, a circle was created with its center on the origin. Its

radius was set to 1.7 in. Then, the Centerline tool from the Sketch Tools palette

was used to create a diameter of this circle. The cursor was placed near the top

of the circle and it hovered around the area until it located the point that

coincided with the circle and was completely vertically above the origin. After

selecting this as the starting point of the line, the second point was created at the

bottom of the circle, also using the technique of hovering until the point was

automatically located. If these automatic constraints are not available, one must

create the centerline and later add the vertical and coincident constraints to it.

Then, the Sketch Trim tool from the Sketch Tools palette was selected, and the

circle was clicked on the right side of the sketched vertical diameter. This

operation left a semicircle as shown in Figure 4.
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Figure 4: Semicircle. The semicircle will be revolved about the centerline to

produce a sphere.

Afterwards, the Revolve... command was selected from the Surface submenu in

the Insert menu, and the semicircle was selected. The revolve parameters were

One-Direction and 360deg. This created a sphere with radius 1.7.

Finally, the sphere was right-clicked and Face Properties was selected. The color

was changed to black (Red 50 Green 50 Blue 50), resulting in a sphere as shown

in Figure 5. In the same fashion, spheres representing oxygen and nitrogen were

created with radius 1.4 and 1.5, respectively. Their colors were red (Red 255

Green 50 Blue 50) and blue (Red 0 Green 128 Blue 255), respectively.
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Figure 5: Carbon atom. This black sphere will represent carbon in the collagen

model. Oxygen and nitrogen will be represented by red and blue spheres.

respectively.

The next step was to incorporate these spheres into an Assembly file,

representing the aggregation of atoms into one large molecule. A new Assembly

file was created, and each atom file was opened. To make each atom in the

molecule, the sphere of the appropriate type was dragged from its Part window

into the Assembly window. Then, the sphere was selected and Move Component

from the Assembly palette was selected. In the Move box, pictured in Figure 6,

the To XYZ Position was selected. The atom's coordinates were entered here.

This process was repeated for each atom in Chain A until the final molecule was

created, which Figure 7 shows.
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Move .................... ..... ........... ... . . .

9 SmartMates

+ ToXZPosition

3.777i _._
; 3.067in

7.824in 

| Apply

Figure 6: Move Component box. The To XYZ Position selection was manually

chosen from its pull-down window. Then, the coordinates could be entered.

Figure 7: Final Collagen 1CGD Chain A model. The complete chain contains 192

atoms.

The file was

into an STL

(*.stl) as the

saved first as a SolidWorks Assembly file. Then, it was converted

file by choosing Save As... from the File menu and selecting STL

file type.

3.2 Catia Approach

In Catia it is simple to work in 3D-space in the Part domain. Two sets of three

chains were created: Collagen 1BKV and Collagen 1CGD. The Catia user

interface is also flexible enough to allow easy editing and reconfiguration of parts
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in 3D-space. Therefore, a template model was made for Collagen 1BKV Chain A,

and models of the other chains were produced by editing this first chain.

3.2.1 1BKV

Catia was la-unched. As Figure 8 shows, from the Start menu and Mechanical

Design submenu, the Part Design domain was selected.

aJ TeamPDM File Edit View Insert Toois Window Help

W 3nfrastructure 1 I

2 -Shape > 0 Assembly Design

Figure 8: Part Design location. Catia features many design interfaces, so it was

important to choose a proper environment for making the design.

Before creating the geometry of the model, a custom tool palette was created.

The Customize... subcommand was chosen from the Toolbars command in the

View menu. A new toolbar was created by clicking the New... button. The new

toolbar, NewToolBaxOO1, was selected in the menu, and the Add commands...

button was clicked. Figu'e 9 shows the Customize window and the location of

NewToolBarOO1.
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Or..,. ,.~~~~~~~~~~~~~MLz_'1

Start Menu I Toolbars I Commands Options 

Toolbars
Sketcher
Sketch-Based Features
Dress-Lip Features
Advanced Draft
Surface-Based Features
Transformation Features
Constraints
Annotations
Boolean Operations
Sketch-Based Features (Compact)
Surfac:e-Based Features (Extended)
Reference Elements (Extended)
Reference Elements (Compact)
Analysis
Insert

New. ,,

Rename...

Delete

e-store- cnte,, ts. . . .

Restore all contents..,

Restore position

I Add commandcs.. |

Remove commands .. J

_ --- __

?Use this page to add or delete a toolbar to the current workbench.
The Commands page allows dragSdrop to adld/remove commands.

Closeag

Figure 9: Customize window. A custom toolbar palette was created here.

The Point... and Sphere... commands were selected in the Commands list

window, pictured in Figure 10, by holding the Ctrl key and clicking, then the OK

button was clicked.
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Points and Planes Repetitior
Points Creation Repetition.,
Polygons Merge...
Polyline ..
Polyline. ..
Porcupine Analysis
Porcupine Analysis
Position along Normal Axis
PositiveLoftHeader

.4 1 . I

-J

Creates one or more points

OK .Close J[o o.- . Co ...I

Figure 10: Commands list window. The Point... and Sphere... conmmands were

chosen from this window.

Then, the Point... command was selected, and the coordinates for the first atom

were input into the Point Definition dialog box, making sure Coordinates was

selected as the point type, and Default (Origin) was selected as the Reference, as

Figure 11 shows. The Collagen-lBKV coordinates, also available at online, list

the coordinates of the first atom as pictured in Figure 11.

M I T� 17 .�j

kV--�

I " 4
Point type: coordinates 3

X = 26451rcrn PC

Y = I7823cm 
, . . . . ., , . . . . . . ;~

W
LR]

Reference

Point: 31-

. OK . Apply I .. Cancel
bear-" ... ..

Figure 11: NewToolBar01 and Point Definition windows. The orange square is

the clicked appearance of the Point... tool.
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To make the sphere, the newly created point Point.1 was selected and the

Sphere... command was chosen fom the custom tool palette. The corresponding

atomic radius-in this case, 1.4 for nitrogen-was input in the Sphere radius

field. The sphere icon was selected as shown in Figure 12 so that a full sphere

instead of a partial spherical surface would be made.

I-- � I

I . -,
Center: [Point. 1

Sphere axis:

Spnere raius: 11.4 

-c S L ..- : - L --
- Spiner LILdI1-ml oIs

Parallel Start Angle: _45_de, _ 

Parallel End Angle:

Meridian Start Angle: [Odeg 

Meridian End Angle: ,30deg I-

OK Apply i O Cancel 

Figure 12: Sphere Surface Definition window. The red X labeled Center is

Point.1. The orange sphere represents the clicked appearance of the Sphere...

command.

Then the OK button was clicked.

This process was repeated for the remaining 183 atoms in Collagen 1BKV Chain

A, resulting in the complete molecule pictured in Figure 13.
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Figure 13: Collagen 1BKV. Note the protruding residue in the middle of the

protein. This is a tell-tale signature of Collagen BKV.

The model was saved as a Catia Part file, the default setting. Then, it was

converted into an STL file by selecting Save As... in the File menu, then selecting

stl as the Save as type.

To make the other two chains, it was not necessary to start this process all over

again. Instead, because the order of the atoms in each chain is mostly identical,

only the location of the points needed to be changed. Each sphere was linked to a

parent point, so when the point moved, the sphere followed it. The only

difference between Chain A and Chains B and C in terms of atomic makeup is

that Chain A lacks the first residue, proline. Therefore, seven additional points

and spheres had to be created to include this residue, using the process detailed

in this section. For the rest of the points, each was double clicked in the Tree,

and its coordinates were changed to the corresponding value of the Chain B, as

Figure 14 shows.

Figure 15 shows the completed Chain B computer model. It too was saved as a

Catia Part and an STL file. Afterwards, the point coordinates were changed to

match those for Chain C, and the model was saved and converted.
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Point type: Coordinates
-- X- _ i

Y ~~~y = -23,498cm

z z= I-14.038cm

Sphere.184 Reference'~~ Sphere.184 ______
Point: alr Point.185 - OK | Apply j Cancel j

"~i pee1. .. :.......... ..... ........Vt ) Sphere.185

Figure 14: Changing the point coordinates. Point.184 was highlightecl in the

Tree, and the new coordinates were entered.

/

Figure 15: Collagen 1BKV Chain B. This chain looks very similar to Chain A,

except it, has the first residue. Chain A does not have information for its first

residue.

3.2.2 1CGD

After the Collagen 1BKV chains were made, it was decided that Collagen 1CGD,

which breaks the repeating residue pattern only once, would be a better model to

produce. All three chains were to be modeled. The two proteins have a very

similar atomic pattern at the beginning and the end of each chain. However, at

atom #64, the two versions diverge. They converge again at atom #73, but after

atom#109, Collagen 1CGD has two extra atoms that Collagen BKV simply

lacks. See Table 1 for a detailed comparison of the two versions at these atom

numbers.
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Table 1: A compansion of 1CGD and 1BKV from atom # 64 to #72.

Atom # 64 65 66 67 68 69 70 71 72

1CGD CD N CA C O CB CG CD OD

1BKV CG CD N CA C O CB OG CG

Due to the differences, a modified approach to creating Collagen 1BKV Chains B

and C from Section 3.2.1 was used to create Collagen 1CGD Chain A. Up to

atom #64, the same method of changing the coordinates of the points was used.

At atom #65, which for BKV is nitrogen and for 1CGD is carbon, the point

coordinates and the sphere radius were changed. At these locations, the sphere

was double-clicked in the Tree, and its radius was changed to the appropriate

size. This process was repeated for each point location in which the atoms of

1BKV and 1CGD are not the same. Two additional points and spheres were also

created because Collagen 1CGD has 192 atoms per chain, while Collagen 1BKV

has only 190.

After the point locations were changed, then the names of the points and their

corresponding spheres were changed to reflect the proper order of the atoms

according to the 1CGD coordinates available online. This was done by right-

clicking each point in the Tree and selecting Properties. Then, the Feature

Properties tab was selected, and the name was changed to reflect its order in the

Chain, as Figure 16 illustrates.

Finally, each residue in Chain A was assigned a unique color to illustrate the

periodic nature of the residues within a collagen chain. Each point and sphere of

a given residue was selected, as dictated by the coordinates spreadsheet. Then,

the group was right-clicked and Properties was chosen, as Figure 17 shows.
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IJ

at- - I -- 
Current selection: Point. 19

Mechanical Feature Properties Graphic 

Feature Name: Point. 192

Creation User:

Creation Date:

Last ModiFication:

More... 

| I OK | - Apply Close |

Figure 16: Properties window. The name was given a new number to reflect the

proper order of the atoms.

25

-J F I l I I I tr...... - ...........



Spher i Center Graph

i Po Pint, Reframe On
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r- Point.
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Figure 17: Selecting multiple objects. Each selected point and sphere belong to

the first proline residue.

The Graphic tab was clicked, and More Colors... was selected from the Color

pull-down box in the Fill section to create a set of custom colors. The Define

Custom Colors button was clicked, and a dark red was chosen (Red 127 Green 0

Blue 0). A blank square in the Custom Colors palette was selected, and the Add

to Custom Colors button was clicked. The same was done for dark blue (Red 0

Green 0 Blue 127) and dark magenta (Red 127 Green 0 Blue 127). Figure 18

shows the resulting appearance of the Color window.
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Figure 18: Color window. Customn colors were created to classify the different

residues in the chain.

The OK button was pressed, and the dark red color was selected in the Color

pull-clown boxes in each of the Fill, Edges, and Points sections. Dark red

corresponded to proline, dark blue to hydroxyproline, dark magenta to glycine,

and black to alanine. The final Collagen 1CGD Chain A model is shown in

Figure 19.

Figure 19: Collagen 1COD Chain A. This representation shows the periodic

pattern of the residue groups.
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To make Chains B and C, the coordinates of each point were changed to reflect

the new values using the same process as in Section 3.2.1. No other changes were

necessary because the three chains in Collagen 1CGD have the same atomic

pattern. The resulting computer models look practically identical to Chain A in

Figure 19 above so are not included individually.
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Chapter 4

Parting Line Feasibility

Both the SolidWorks and Catia approaches produced functional STL files to use

in manufacturing a solid model of a collagen protein. However, there are many

options available to manufacture a model, as Section 2.4 details. My colleague

Emily Cofer pursued the different manufacture options and determined the

proper method to fabricate a part from the computer model. My role in this

investigation was to determine if a traditional parting line could be created for a

hypothetical rigid mold of this model. The results of this process steered the

direction of the manufacturing process selection from conventional methods, like

injection molding, to more complex methods, such as room temperature

vulcanization.

4.1 Criteria for Translational Motion only

Common rigid molds consist of two halves: the cavity and the core [7]. When

they are put together, they leave a space. This space has the shape of the desired

part. An example of a mold cross-section is pictured in Figure 20.

In the basic molding process, the mold halves are put together, the space between

the molds is filled with the part's material, the part material hardens, and the

mold halves are removed from the part. Of course, this explanation ignores other

essential requirements of molding. Only the geometry of the molding process is

relevant for determining the feasibility of incorporating a rigid-mold parting line.
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Figure 20: Mold cross-section. The space between the mold halves is the shape of

the cast that will be produced in them.

Figure 21 illustrates the basic process of removing rigid mold halves. Again,

many basic molding necessities are ignored; only the geometry is relevant. Also, it

is assumed that the molds only undergo translational motion. Rotation of the

mold, such as for a spiral, is studied in Section 4.2.

Figure 21: Removing the mold halves. There must be clearance for the mold

halves to slide away from the part
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The molds must translate away from the part. If the molds and the fabricated

part are all rigid, then the geometry must accommodate the separation of the

part from the mold. (If either the mold or the part is flexible, then it can change

its shape to accommodate geometry that would otherwise prevent the separation

of the two.) Figure 22 shows three mold cross-sections. The first two have

geometry that accommodates the separation of rigid parts. The third cross-

section, however, has a shape that prevents the separation of the part inside it.

Figure 22: Mold cross-sections. The first two molds have geometry that allows

the part to slide out, but the third mold has geometry that prevents the part

from sliding out.

The key to successful removal of rigid parts lies in the convergence of tangent

lines in the contour of the cavity. Reexamining the three example cross-sections

from Figure 22 above, one can see a difference in the convergence of the tangent

lines of the cavity contours. In Figure 23 below, for the first mold cross-section,

the tangent lines of the cavity contour converge into the direction of the mold.

For the second mold, the tangent lines are parallel and never converge. In the

third mold, the tangent lines of the cavity contour converge away from the

mold-that is, they diverge into the mold.
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Figure 23: Convergence of tangent lines to mold contour. As long as the lines do

not diverge into the direction of the mold, the cast part is able to slide out.

Also note that the contour of the mold cavity is one and the same as the contour

of the cast part itself. Therefore, the criterion for successful removal of a rigid

part from a rigid mold with only translational motion is that the tangent lines of

the contour of the part never diverge into the mold.

4.2 Criteria for Rotational and Translational Motion

The allowance of rotational motion when separating the part from the mold

yields additional part design possibilities. Primarily, screws, spirals, and other

helical patterns are possible. If rotational motion is prohibited, then spiral shapes

with "holes" in the middle would not be able to be removed from molds because

they wrap around the mold material. They would have to be twisted out of the

mold, very similar to unscrewing a screw. In this case, though, the same contour

tangent line criterion applies. As Figure 24 shows, if the spiraling contour has

any concave features, it will not be able to be unwound from inside the mold.
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Figure 24: Cast part with helical contour. The cast part must be twisted out in

the direction of the arrow. If its geometry includes a bump as shown, it will not

be able to be removed. This is an extension of the converging tangent line

criterion.

4.3 Parting Line Feasibility in Collagen Residue

In order to determine if a collagen chain solid model could be fabricated using

rigid molds, it must be put to the tangent line divergence test described in

Sections 4.1 and 4.2 above. The computer model whose creation is detailed in

Section 3.2.1 above was used to examine the geometry of collagen and determine

the feasibility of using a rigid mold.

If part of the collagen chain does not fit the rigid-mold parting line criteria, then

the whole chain must not either. The first three residues of Collagen 1BKV

Chain A were examined to test the parting line feasibility. As Figure 25 shows,

each atom was assigned a unique color. This aided in identifying the orientation

of the residue triplet when seen from different points of view.
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Figure 25: First residue triplet. Hydroxyproline is blue, glycine is purple, and

proline is red.

The most logical direction to place a parting line would be where the part is at

its most horizontal. That way, the features of the part are distributed along the

surface of the mold, and there would be the least chance that the tangent line

criterion fails. Figure 26 shows a simplified representation of this explanation.

Figure 26: Horizontal vs. vertical orientation. The horizontal orientation on the

left allows for a piece to be removed when the molds separate. However, the

vertical orientation on the right does not allow the removal of a cast piece.
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The residue triplet was examined at its most horizontal orientation. A horizontal

plane was added to the triplet, separating it into top and bottom halves. The

plane made it easier to visualize the angle of the tangent lines of the contour of

the triplet. igures 27 and 28 collectively show that the counter tangent line

criterion fails. Every time a sphere is intersected by the plane but not through its

center, it runs the risk of not fulfilling the tangent line criterion. Figure 26 above

illustrates this: the first mold interfaces at a plane that intersects the two circular

cross-sections through their center. However, the second mold interfaces at a

plane that does not intersect the circular cross-sections in their centers.

Figure 27: First residue intersected by plane, isometric view. The plane makes it

easier to visualize the angles of the tangent lines to the surface counters with

respect to the plane.

One can visualize that no matter the height or the orientation of the plane, at

least one sphere will not be intersected through its center. Therefore, at least one

pair of tangent lines will diverge into the hypothetical mold location.
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Figure 28: First residue intersected by plane, side view. The red lines show two

examples of tangent lines that would diverge into the theoretical mold.

Figure 29 shows a rotated view of Collagen BKV. The spiral pattern is not

easily observed when the model is oriented to show its length. However, this

rotated view shows that collagen is a spiral shape with a "hole" in the middle.

Because the helical contour also has many concave features, it fails the parting

line tests described in Section 4.2.

Figure 29: Spiraling nature of Collagen 1BKV. The molecule has the shape of a

spiral that makes a complete revolution and has a "hole" in the middle.

And thus, it was demonstrated that the collagen model could not be

manufactured using rigid molds.
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Chapter 5

Ball-and-Stick Collagen Model

A computer model of ball-and-stick Collagen 1CGD A was begun. Although its

progress was halted in order to make computer models of Chains B and C, it

could be completed following the steps detailed below.

First, the entire model was highlighted by selecting Open-body.1 in the Tree.

Then, this selection was right-clicked, and Hide/Show was selected, resulting in a

blank workspace for the time being.

The next step was to create new, smaller spheres to represent the atoms. For

each atom, its corresponding point was selected from the Tree. Then, the Sphere

icon from the custom palette was clicked. In the Sphere Surface Definition dialog

box, the radius was entered as 0.5 and the full sphere icon selected. The OK

button was clicked to make the sphere. Each point was selected, and a sphere of

radius 0.5 was created in this way.

To differentiate between the types of atoms, different colors were assigned to the

spheres using the same technique as described in Section 3.2.2. The same scheme

as in Section 3.1 was used: black (Red 50 Green 50 Blue 50) for carbon, red (Red

255 Green 50 Blue 50) for oxygen, and blue (Red 0 Green 128 Blue 255) for

nitrogen. The result for the first three residues is shown in Figure 30 below.
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Figure 29: Isolated spheres in ball-and-stick model. These spheres represent the

atoms in the first residue triplet.

In order to continue, new commands had to be added to the custom menu. The

Customize subcomnmand was choseni from the Toolbars command in the View

menu. The custom toolbar was selected in the Toolbars tab, and the Add

commands... button was clicked. In the Commands list window, the selections

Circle..., Extrude..., Line..., and Plane... were each control-clicked. Then, the OK

button was clicked, and the Close button in the Customize window was clicked.

The resulting custom palette is shown in Figure 30.

iKo<4js

Figure 30: Further customized NewToolBar001 palette. The Circle..., Extrude...,

Line..., and Plane... commands were just added.
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While some of these commands are readily available in other menus and/or

toolbars, it is more convenient to store them all in one location.

The next step was to create lines between spheres. These represented the bonds

between bonded atoms. They would be used to create cylinders, which would be

the "sticks" in the ball-and-stick model. The location of these lines-that is,

which spheres they connected-was not trivial. An image of an outside ball-and-

stick Collagen model was consulted to determine the proper line locations.

The following connection pattern was detected:

Proline: N-CA, CA- C, C- 0, CA- CB, CB-CG, CG- CD, CD-N.

PRO-HYP: C(PRO)- N(HYP)

Hydroxyproline: N-CA, CA-C, C-0, CA-CB, CB-CG, CG-CD,

CG-OD, CD-N.

HYP-GLY: C(HYP)-N(GLY)

Glycine: N-CA, CA-C, C-0

GLY-PRO: C(GLY) to N(PRO)

To make a line, the Line icon was clicked in the custom palette. Point-Point was

automatically selected in the Line type field, but if this is not the case, be sure to

select Point-Point. Then, No selection in the Point 1 field was automatically

highlighted. According to the Collagen-lCGD spreadsheet, atom #1 is N in the

first pro residue, and atom #2 is CA in the same residue. Therefore, Point.1 in

the Tree was clicked for the Point 1 field. No selection in the Point 2 field was

now highlighted, and Point.2 in the Tree was clicked, making the Line Definition

window appear as shown in Figure 31. The OK button was clicked.
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Figure 31: Line Definition window. This tool can make a line between two points.

This process was repeated for the points representing the atom pairs listed above,

until they were all completed. Then in the Tree, all the Line items were selected,

the collection was right-clicked, and Properties was selected. Under the Graphic

tab, cyan was chosen in the Color pull-down menu in the Lines ad Curves

section. Also, in the Thickness pull-down menu, 2 was chosen for extra visibility.

The OK button was clicked, and the result is shown below in Figure 392.

QA~.. _ _&

.@@

Figure 32: Spheres and lines in ball-and-stick model. Cylinders will be made,

centered on each cyan line, to represent the "sticks."
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Next, for each line, a plane normal to the line and coincident with one of the

endpoints was made. The Plane... icon was clicked from the custom palette, and

Figure 33 shows the Plane Definition window that opened. Plane type was

changed to Normal to curve, and Line.7 and Point.1 were chosen as the

parameters, resulting in the green plane also picttured in Figure 33.

Plane type: 

Curve: 

; J P: Point, 1

OK 1 .4 Apply I Cancel I
-. 1 11 ~~ 1, -

Figure 33: Plane Definition window. These parameters created the green plane

coincident with the center of the blue nitrogen atom.

The OK button was clicked to make the plane. Planes were made for every other

line in the same manner. Afterwards, circles were made on the planes, using the

preexisting points as centers. The Circle... button was clicked in the custom

palette. In the Circle Definition window as pictured in Figure 34, Point.7 and

Plane.2 were selected as parameters. The radius was set to 0.25. Then, the full-

circle button in the Circle Limitations area was clicked. OK was clicked, and the

circle in Figure 35 was made. This process was repeated for every other plane.
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Center: Point,7
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Figure 34: Circle Definition window. The radius was set to 0.20 and the full-circle

icon selected.

Figure 35: Circle on plane. The circle will be the base of a cylinder that touches

two atoms.

Finally, the cylinders were made by extruding the circles along the lines, using

the Extrude... tool. A length of 1.4 was chosen, as shown in Figure 36, for the

cylinder.
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Figure 36: Extruded Surface Definition window. The length of the cylinder, 1.4, is

a length that will always connect two spheres in the model.

This was repeated for each circle and line until cylinders were made on all of them. The

final figure, the first residue triplet of Collagen 1CGD Chain A, is shown in Figure 37

below.

I

Figure 37: Collagen 1CGD Chain A ball-and-stick model of first residue triplet.

This model shows the bonds between the atoms.
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The original spheres, Sphere.1 through Sphere.19, were unhidden by right-

clicking them in the Tree and selecting Hide/Show. Then, they were right-clicked

and Properties was selected. In the Graphic tab, the Transparency slider was set

to 132. This made the space-filled spheres semitransparent, showing how the

space-filled model fits with the ball-and-stick model. Figure 38 shows the triplet

in ball-and-stick mode with a semitransparent space-filled visualization.

Figure 38: Space-filled and ball-and-stick overlay. This shows the relative sizes of

the space-filled spheres and the ball-and-stick spheres. While the ball-and-stick

model lacks a true geometric representation, it makes up for this by showing the

bonds between atoms much better.
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Chapter 6

Conclusions

Space-filled STL files of the three chains for each of Collagen 1BKV and Collagen

1CGD were made. The process to recreate these models or other similar models

was painstakingly detailed. A parting line with rigid molds was demonstrated to

be infeasible for the geometry of this project. And, a ball-and-stick model for

Collagen 1CGD was begun. The process to complete the model was detailed.

I definitely learned much about both SolidWorks and Catia that I had not been

exposed to before undertaking this thesis. While I have successfully used

SolidWorks in the past to design computer models, I found its resources lacking

for this particular project. I found Catia to be a much better tool, but in the

process I had to teach myself how to use it. My only experience with Catia

software is using a Unix-based version for several months. The difference between

that version, Catia V4.2, and the version available on Windows, Catia V5, is

quite staggering. The user interface, while still powerful and flexible, changed

considerably from its previous counterpart. That said, I would even recommend

Catia V4.2, if I had access to it, to continue work on this project. It is able to

perform functions, such as making cylinders between any two points in 3D-space,

in a single step. As detailed towards the end of Chapter 5, I had to create lines,

plains, circles, and extrusions to achieve this same effect. All in all, I would say

the solid modeling program experience was quite an adventure and discovery

process.
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The parting line determination was successfully completed with the help of

computer models. An even more detailed analysis could be conducted using a

rapid prototyped part and experimenting with mold geometries. After all, if the

collagen protein is divided enough times into separate pieces, at some point each

of these pieces will be able to be cast in rigid molds. Then, the pieces could be

attached to each other after the casting took place. It becomes a question of how

many different pieces is acceptable, and if the use of a rigid mold is worth the

time and effort it takes to assemble the part.

Additional fture work on this project could be directed to completing the ball-

and-stick model. However, with this recommendation come some caveats.

Whereas the absolute units of measurement for the space-filled model was

irrelevant as long as the relative proportions were held true, this is not the case

for the ball-and-stick model. Figure 38 on page 40 shows that the geometry of the

spheres and cylinders for the ball-and-stick model is much smaller than that for

the space-filled model. One must consider the physical limitations of current

manufacturing processes; specifically, can the process accommodate geometry this

small? While my thesis did not direct attention at the manufacture process

selection, this is nonetheless a very important consideration.

Overall, the efforts of this and Ms. Cofer's thesis produced a working physical

model of Collagen 1CGD. Additionally, there are electronic materials for future

improvements to the collagen model, or instructions one could follow to design

entirely different proteins. Therefore, I would judge that this project successfully

fulfilled its goals.
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